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AGENDA

Messages

Project planning and prototyping

Using prototypes in concept evaluations
Digital Fabrication

Electronics

Supervision after lecture
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THE ITPDP PROJECT

Mon

Wed

Course Schedule 2/3

L8 16/3
Concept
Development
(Simon)

E8 18/3

Ideation & concept
development

20/3
Supervision session
9-11 (TAs)

- Finish Fusion 360 &
Al and AID tooling
exercises and watch
the PROTOLab video
by 23 + read articles

Tooling exercises:

DEPARTMENT OF COMPUTER SCIENCE
/ \ ¥ 4
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L9 23/3

Sketching User
Experiences (Minna)
+ 14-16 PROTOLab
intro (Simon/Gustav)
24/3
12:00-16 PROTOLab
intro (Simon/Gustav)

E9 25/3
Sketching humans

and storyboards
(Minna + TAs)

Sub-assignment 2: Field Work [BS/G]

Teachers and TAs feedback

\%%

Work on sub-
assignment 2

Easter break
2/4-6/4

PHYSICAL PROTOTYPING
13. APRIL 2026

3073

- Sketch storyboards

EX Tue 7/4
Pitch Workshop

11:30-14:30
(Anne/The Kitchen)

P Thu9/4

Design pitches
10:00-12:00 (All)

- Prepare PPT &
pitches for 3 ideas
for Thu

- Finish sub-assign. 2

Sub-assignment 3: Design concept [BS/G]

E10 1374

Physical
Prototyping
(Simon)

15/4
Supervision
10-11:30 (Simon)
+ watch Academic
writing + Related
works video (Bs)

- Watch the video
and read the articles
before next Mon and
Wed lectures

TAs feedback

SIMON HOGGAN CHRISTENSEN
LAB COORDINATOR

L= lecture

E=T@ sessions & practical exercises
IW= Individual/group work

A= Assignment hand ins

P= Design or Demo presentation
GIT= Delivered via gitlab.au.dk
BS= Delivered via Brightspace

|= Individual delivery

G= Group delivery

L11 20/4

Prototyping &
Academic writing +
Related works Q&A
(Clemens)

ET1 21/4
Academic writing
Exercises (TAs)

L12 22/4
GUI Design

(Minna)

- Start gathering
related works

- Finish sub-
assignment 3

E12 27/4
Figma prototyping
12:00-15:00

(Guest: Maja & Julia)
\%% 29/4
Work on sub-
assignment 4

1/5

Supervision

10-11:30 (Simon)

- Finish sub-

assignment 4

Sub-assignment 4: Related work [BS/G]

TAs feedback
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THE ITPDP PROJECT

Course Schedule 3/3

L15. Tue26/5 | w 6 I°

Exam info
(Minna / Simon)

w 3/6

Final report writing
& demo video

- Finish the report by
Thursday

L= lecture

E=TQ sessions & practical exercises
IW= Individual/group work

A= Assignment hand ins

P= Design or Demo presentation
GIT= Delivered via gitlab.au.dk

BS= Delivered via Brightspace

|= Individual delivery

G= Group delivery

1176

1%t iteration poster
presentation &
feedback session at
10-12 (Minna & TAs)

W

Finalizing the
prototype and

poster for the final
exhibition

- Finish the poster
based on the
feedback and
upload it to Dropbox
by 17 June at 12:00

P 4/5 11/5 L14 18/5
Mon | Prototype Demo Conduct and Logo design Poster design
Day 12:00-15:00 report user (Minna) (Minna)
evaluations
L13+EI3  6/5 El4 20/5 | E15 7/5
Evaluation (Minna) W 13/5
+Evc|gction Logo design Poster design
weg] Planning (TAs) exercises exercises
ed Conduct and 9975
8/5 feport user Supervision S isi e
Supervision evaluations \ ] uper\'/|5|on'
10-11:30 (Slmon) 10-11:30 (S|mon] 10-11:30 (Simon)
-Write the design  _Finjsh sub- -Analyze user study - Finish sub- _
W and implementation  ggsignment 5 by Tue  results assignment 6 by Fri
section
-Prepare for the user
evaluationst J
|
J i
A |

Sub-assignment é: Evaluation [BS/G]
DL: May 29" at 15:00

H TAs feedback

Sub-assignment 5:
Design & implementation [BS/G]
DL: May 12" at 15:00

TAs feedback
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|
Product poster [BS/G]
DL: June 4" at 13:00 DL: June 17t at 12:00

26th Jun

P 22/6

Final prototype
exhibition with a
product poster

Exams

9:15-> )
Chomsky cleaning
& course evaluation
discussion

- Everyone needs to
be present in the
demonstration, exam,
& cleaning of the
Chomsky & Feedback
discussion.
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TH E ITPD P PROJ ECT From Brightspace under “ITPDP 2026

/v

Presented at first lecture about course introduction

Eligibility for exam

To be eligible for the exam, each student must hand in all tooling exercises and supporting assignments, and every group must
hand in the final report, be represented in the plenary sessions, and - of course - the exam related demo session and oral exam.

Goals and requirements for the final project
The IT product must be placed clearly in relation to one of the three subthemes (or have deviation agreed upon with course
educator).

The group must demonstrate an understanding of the target user group's needs and conditions, using theory and tools introduced
in this course, and/or theory/tools presented earlier in their study programme.

The solution must position itself as relevant to the future users, utilizing ethnomethodological work and user-centered design to
ensure validity. A successful evaluation is however not a requirement, but reflection and analysis of validity, process and outcome
Is the main end result.

The context of use and the challenges identified in the user studies must be taken into
account,

The solution must include multiple clients/components and the cloud (typically via web
technology). Several subcomponents and resources that can communicate, e.g., a system with a mobile
app, a physical installation, and with automatic storage of sensor data in the cloud.

The IT product may involve a smartphone as part of the solution, but there must be an interaction with physical/tangible
components in the environment or on the user, which you have designed and fabricated yourself.

Arguments must be made based on the needs of the users, usage of theory and methods, and the business potential in relation.
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WORKLOAD AND EXPECTATIONS

European standard: 1 ECTS = 25-30 hours of work.

For Aarhus University, it has been set at 28 hours.
ITPDP is slightly different.

First part (seen as a 5 ECTS course): 140 hours per person, including lectures/TQ,
from 26th of January to 17th of March.

Second part (seen as a 15 ECTS course): 420 hours per person, including lectures/T®, from
18th of March to June 17th. This is equal to a minimum of 32 hours per week.

The rest of the course schedule is exam period and exam preparation time.
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WORRYING TENDENCIES

/v

Resource hour overview:

Estimated teaching time: 68-70 hours, not including supervision.

1 person group: The overall project should reflect 490 hours of work.
2 person group: The overall project should reflect 980 hours of work.
3 person group: The overall project should reflect 1470 hours of work.
4 person group: The overall project should reflect 1960 hours of work.

In the current state, your project should currently represent roughly 230 hours per person.

For a three person group = 425 hours of work (30% deducted, prioritization)

Can you honestly say that you have put this time into the project, preparation, lectures,
reading etc.? If yes, then great!
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PROJECT PLANNING

A university course.

Project planning and implementation is part of the learning outcomes - we cannot quide
and/or hand-hold you the entire way.

Make sure to keep yourself updated via the Course Schedule on Brightspace.
Please ignore all other sources, as mentioned multiple times.

Be present... We cannot teach or supervise students who do not show up.

You can technically stay away from now until final report and exam, as long as Interview
Assignment and Tooling Exercises are done. But don't.
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“... Version of a product with just enough
features to be usable by early customers”
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MINIMUM VIABLE PRODUCT (MVP)

Often a term used in “Agile Prototyping”.

A way to create clear goals to be able to evaluate/validate a prototype/concept.

What is the minimum features our prototype needs to have, in order to solve the identified
problem and/or answer the research question?

Build towards simplistic representations of your vision — not individual small parts.

=y = How not to build a Minimum Viable Product
O O In—n) O

- - How to build a Minimum Viable Product
— o S (SEE

Agile Prototyping for technical systems - Schuh etal. %
g / <
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BUT HOW DO YOU PLAN THIS?

Must have: Non-negotiable, primary need

)
s Should have: Highly desirable, very important

Could have: Nice to have, optional

w Won’t have: Not necessary (for now)

https.//activecollab.com/blog/project-management/moscow-method
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MoSCoW EXAMPLE - KITCHEN TIMER

- Timer can be set (up to 24 hours)
- Hours, minutes and seconds

But... how - User.gets multlmodclll feedback
- Multiple concurrent timers

do we » - Small enough to carry

prioritize - Battery lasts for full longitudinal

these?? study duration

Must have
Timer = multiple weeks? Will not have
- Smartphone connected
- Contextual multimodal feedback
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HOW TO PRIORITIZE POST
MOSCOW
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HOW TO PRIORITIZE IN MoSCoW

Aim high, scope appropriately - you should push yourself.

Free Features First
Impact-analysis (Remember scenarios? Personas? Contextual Design?)

The art of choosing the right ecosystem/backbone

Pessimistic approximations
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AIM HIGH, SCOPE APPROPRIATELY

Push yourselves, but lean into your skillset.

Always scope based on project goals (in this case course goals and delimitations).

Do not let an overly simple MVP set you back.

An MVP is built to be your fallback - leave it alone, document, take pictures, make videos.

Your MVP is then baseline for next iteration.
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IMPACT ANALYSIS

Focus on scenario-based design and contextual design - use it!
Which features will have the most (positive) impact?

You understand your user and the context - use the analysis to strengthen arguments for
feature prioritization.
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IMPACT ANALYSIS - KITCHEN TIMER

- Timer can be set (up to 24 hours) 7/
- Hours, minutes and seconds

- User gets multimodal feedback @

- Multiple concurrent timers ) 2

- Small enough to carry 7] ]

- Battery lasts for full longitudinal r”@
%)  study duration

Must have

Timer = multiple weeks? Will not have
- Smartphone connected
-  Contextual multimodal feedback
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“FREE FEATURES FIRST”

Free features are not necessarily free, but requires very little technical reiteration.

Hardware vs. software

Simple additions or changes

N 2
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IMPACT ANALYSIS - KITCHEN TIMER

- Timer can be set (up to 24 hours) %ﬁ

- Hours, minutes and seconds
- User gets multimodal feedback @
- Multiple concurrent timers ) 2

- Small enough to carry 7] ]

- Battery lasts for full Iongitudinolrll
%)  study duration

Must have
N/\V&V/ 1

N

- Timer = multiple weeks?Ig 2% Wil At R
- Smartphone connected g ¥
- Contextual multimodal feedback
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TIME AND SPRINTS

/v

Aqgile development methodologies often refer to the term “sprint”.

| strongly suggest using this approach for testing feasibility in feature-based prototyping.

Suggested framework for prototype sprint:
Inspired by the often used “5-day design sprint” (or similar artzy naming scheme)

Following MoSCoW prioritization and free-features-first analysis.
Have initial brainstorm about implementation strateqy.
Divide most crucial features up, and sprint them in pairs.

Work 24-72 hours on each feature depending on impact (two features being worked on
simultaneously).

End with feasibility assessment and construct time plan based on last sprint. Or scrap.

DEPARTMENT OF COMPUTER SCIENCE PHYSICAL PROTOTYPING SIMON HOGGAN CHRISTENSEN
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PROTOTYPE EVALUATION
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THE FALLACY OF FLAWLESS

Prototypes are inherently flawed.
Small factors and variance makes a difference for replicability and comparability.
The obvious end-goal is a self-sustained and robust system.

Often that is not the case...
and maybe not the best and easiest way to add additional features?
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WIZARD OF OZ

[ ]
The Wizard of 0z Method
The facilitator & the participant The “wizard” controlling
the interface
https.//www.nngroup.com/articles/wizard-of-oz/
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Maryam Tohidi, William Buxton, Ronald Baecker,

T and Abigail Sellen. 2006. Getting the right design
F I I H F I D E LI Y F E E D B I( onaihe cesenront
J )

and

Youn-Kyung Lim, Erik Stolterman, and Josh
Tenenberg. 2008. The anatomy of prototypes:
Prototypes as filters, prototypes as manifestations

End goal of a prototype evaluation: of design ideas
* To validate concept

* Evaluate user appropriation

* Problem-solution fit

* Feedback on future iterations

Prototype fidelity matters!
Users find it easier to critique lower fidelity prototypes.

Sometimes using multiple low-fidelity, feature-focused prototypes is the right way...
.. For evaluation ©
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DIGITAL FABRICATION
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MANUFACTURING METHODS

Additive Manufacturing Subtractive Manufacturing

3D printing as example CNC (Computer Numerical Control)
milling as example

Adding layer by layer Taking away layer by layer
Material base = often plastic Material base = often metals/wood
Often used for fast initial prototyping Often used for sturdy construction

Combo =
Hybrid Process
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Meh?

1. What type of features does your product have?
* small organic and intricate features — additive methods
* large or sharp features, drilled and tapped holes or other fastening features —subtractive methods

2. What type of material do you want to work with?
» thermoplastics and resins — additive methods
 materials like metals, wood, or foam — subtractive methods

3. How many units do you want to produce?
* low-volume production or iterative prototyping — additive methods
* large-volume production runs — subtractive methods

Meh?



RAPID PROTOTYPING

/v

Purpose: Rapidly creating tangible artifacts or prototypes to filter/validate certain aspects.

Addendum: In house. By yourself. Something you hopefully made. Without ruining yourself...

.. or the equipment ©

Most common practice and understanding:
Utilizes digital fabrication, due to speed and work/process synchronizity.

Any fabrication occupying more than a few days is no longer rapid prototyping - it’s
Invested construction.

Invested construction is not a bad thing - perfect for prototyping towards final demo.

Rapid prototyping is your tool to quickly test, validate and scrap. Anything too detailed -
and invested - in can become hard to scrap.

DEPARTMENT OF COMPUTER SCIENCE PHYSICAL PROTOTYPING SIMON HOGGAN CHRISTENSEN

13. APRIL 2026 LAB COORDINATOR
AARHUS UNIVERSITY



RAPID PROTOTYPING

Mastering techniques, process, equipment

Absolute control regarding time and scope

2mm extrusion width
1mm layer height
8 minute print

1.2mm extrusion 0.4mm extrusion width |0.4mm extrusion width
width 0.3mm layer height
0.6mm layer height

0.08mm layer height
30 minute print
15 inute print

2 hr print

\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\
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ARDUINO

DEPARTMENT OF COMPUTER SCIENCE
/ \ ¥

AARHUS UNIVERSITY

PHYSICAL PROTOTYPING
13. APRIL 2026

SIMON HOGGAN CHRISTENSEN
LAB COORDINATOR

PRANALDY
2 o,

9%,

o s,

£, »
M575 g oS

L) o
fv'.X “‘*\)



AGENDA

* Why Arduino for prototyping

 Alternative prototyping platforms (and what you will be taught about in
other courses)

 Code examples

e ESP32 Wizard of Oz
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ARDUINO AS PROTOTYPING PLATFORM

Readily available here and big part of our lab-ecosystem

Lots of documentation and code examples + tutorials

Easy prototyping, hook-up, HATs, powering etc.

Many variations, sizes and beefiness

Often limiting: CPU/GPU power, threading/cores, memory, GPIO pin amount, buffer sizes,
communication.
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ALTERNATIVE PLATFORMS

Wemos D1 Mini (cheap WiFi board based on ESP8266)

ESP 32 (great platform with lots of possibilities)
RPI (when you want something in between a PC and an Arduino)
ATMEL MCU family (used in PhysComp. When you want to create custom circuits)

NUCs/Smartphones (for webapps/apps, graphics-intense tasks)
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ARDUINO IDE

Arduino is an open-source electronics platform based on easy-to-use hardware and software.
https://www.arduino.cc/en/software

VERIFY/UPLOAD SELECT BOARD & PORT OPEN SERIAL MONITOR

nm AnalogReadSerial | Arduino IDE 2.0.0-rc9
Arduino MKR WiFi 1010 v \/\ 0O

‘ GULER g TCHBOOK
1 /%
2 AnalogReadSerial OPEN SERIAL PLOTTER
‘ BOARD MANAGER
4 Reads an analog input on pin @, prints the result to the Serial Monitor.
W—

ecentation is avallable using Serlal Plotter (Tools > Serlal Plotter menu).

7

8 i xample code is in the public domain.
g DEBUGGER
10 i i i

https://www.arduino.cc/en/Tutorial/BuiltInExamples/AnalogReadSerial
11

12
13 // the setup routine runs once when you press reset:
14 void setup() {

15 // initialize serial communication at 9600 bits per second:
1A Carial hanin/OQRAN)N.
pf‘ﬂ” W,
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https://www.arduino.cc/en/software

ESP32

ESP32 is widely used in System-on-Chip (SoC) solutions
designed for Internet of Things (loT) applications due to its:

- Integrated WiFi and Bluetooth

- Lower power consumption with deep sleep modes

- More I/O Features (than Arduino)

13. APRIL 2026 LAB COORDINATOR
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Absolute max per pin 48mA
reccomended 2emA
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& absolute max 266mA
for entire package
pcInT1zH ADCS SCL | @ #3 on
pcInT12H ADC4 SDA
rrr——
AREF
fpcInTs SCK 7
PB4H 12 { PCINT4 MISO
PE3H 11 0C2A H PcInT2 MOSI
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oD
[ropepacrn Power
PCINTS SCK Control
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Pin Function
Digital Pin
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ESP32
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ARDUINO V.S. ESP32 V.S. ESP8266

Feature
CPU
Memory
Wi-Fi
GPIOs
Power
Analog
Security

Best For

Arduino

8-bit, 16 MHz
Low (2 KB SRAM)
No

~14

High consumption
10-bit ADC

Basic

Simple projects

DEPARTMENT OF COMPUTER SCIENCE
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ESP32

Dual-core, 240 MHz

High (520 KB SRAM)

Yes (Wi-Fi + Bluetooth)
~34

Low-power modes (~5uA)
12-bit ADC + 2 DACs
Hardware encryption

loT, Al, wireless apps

PHYSICAL PROTOTYPING SIMON HOGGAN CHRISTENSEN
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ESP8266

Single-core, 80-160 MHz
Moderate (160 KB SRAM)
Yes (Wi-Fi only)

~17

Deep sleep (~10uA)
10-bit ADC

Basic

loT with Wi-Fi



ARDUINO COMPONENTS
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COMPONENTS - WHAT OPTIONS DO WE HAVE?

- Many components will be covered in Physical Computing next semester:

- Entire lecture set on sensors and what types we have in lab as inspiration.
Engineering Interactive Technologies delves further into making novel sensing

techniques.

- Entire lecture set on actuators - even more time to delve into actuators in
Multimodal Interaction and Shape Changing Objects and Spaces

- For now: Use Johannes’ component inspiration kit and chomskylab.dk - and talk to
supervisors/TAs/Labtools for further advice/inspiration.
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ARDUINO CODE EXAMPLES
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ARDUINO CODE EXAMPLES

“AnaloglnOutSerial.ino”
“Arrays.ino”
"Smoothing.ino”
“switchCase.ino”

WiFi network examples (third-party examples)
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ANALOGIN
OUTSERIAL

Example of map
Example of analogRead
Example of Serial.print
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analogInPin = AO;
analogOutPin = 9;

sensorValue =
outputValue =

setup() {

sensorValue analogRead(analogInPin);

outputValue = map(sensorValue, 0, 1023,

ogWrite(analogOutPin, outputValue);
rint("sensor = ");
rint(sensorValue);

print("\t output = ");
printin(outputValue);

v

’

)5

G

-




timer = 100;
ledPins []
71 41 'E‘v

]
1

()]

’ >

ARRAYS B

setup() {

. . for ( thisPin = @; thisPin < pinCount; thisPin++) {
Array example because slightly different o inMode(ledPins [thisPin] . OUTPUT):
syntax compared to java
loop() {
for ( thisPin = @; thisPin < pinCount; thisPin++) {
digitalWrite(ledPins [thisPin], HIGH);
delay(timer);
digitalWrite(ledPins[thisPin], LOW);
for ( thisPin = pinCount = 1; thisPin >= @; thisPin-—-) {

digitalWrite(ledPins [thisPin], HIGH);
delay(timer);

digitalWrite(ledPins [thisPin], LOW);

/ DEPARTMENT OF COMPUTER SCIENCE PHYSICAL PROTOTYPING
v 13. APRIL 2026

AARHUS UNIVERSITY




numReadings = 10;
readings [numReadings];

readIndex = 0;
total = 0;

RUNNING AVG

setup() {

"Smoothing.ino” in Arduino--> Examples

( thisReading = @; thisReading < numReadings; thisReading++) {

readings [thisReading] = 0;

Running average data smoothing

Useful for sensor and input with noise

Noise = variance in data without change in input S e S R

readIndex = readIndex + 1;

if (readIndex >= numReadings) {

readIndex = 0;

b

average = total / numReadings;
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I
[aon]

sensorMin
sensorMax = 600;

Crucial for ITTT cases and sensing

sensorReading = analogRead(AQ);

range = map(sensorReading, sensorMin, sensorMax, @, 3);

(range) {

Serial.printin("dark");
Serial.println("dim");
serial.printin("medium");

Serial.println("bright");
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ESP32 EXAMPLE - YOUR WOZ CHEATSHEET

]
§ ESP32 Dev Module v

ESP32_WiFiWorkshopFinal.ino
1 L

ESP32 is a brilliant platform for the Wizard of Oz method.

* ssid = "AU-IoT";
* password = "test1234";

WiFiServer server(80);

Example code in Brightspace.

u riat t
String output26State = "off";
String output27State = "off";

Simple Ul via WiFiServer = interaction with ESP32 mo

currentTime = millis();

previousTime = 0;
nom
timeoutTime = 2000;

Easily adaptable.

egin(921600);

[ L

ode (output26, OUTPUT);

pinMode (output27, OUTPUT);
I

di e(output26, LOW);
= (output27, LOW);

Of course only used for evaluation and prototyping, not the

t("Connecting to ");
rintln(ssid);
in(ssid, password);

final demo © MLt .

Fi connected.");
ad )5
WiFi.localIP());
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INSTALL THE ESP32 BOARD IN ARDUINO IDE

- Open IDE and go to Tools > Board > Boards Manager
- Search "ESP32", select "esp32 by Espressif Systems"”, and click Install
- Reopen Arduino IDE

- Under Tools>Board you should see esp32 > ESP32 Dev Module option
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BOARDS MANAGER

esp32

Type: |All

Arduino ESP32 Boards
by Arduino

Boards included in this package:
Arduino Nano ESP32

2.0.18-¢ v

esp32 by Espressif
Systems
Boards included in this package:

ESP32 Dev Board, ESP32-C3 Dev
Board, ESP32-C6 Dev Board,...

More infd

3.20 v




INSTALL USB CABLE DRIVER

Download Link: https://www.silabs.com/developer-tools/usb-to-uart-bridge-vcp-drivers

- Windows Users: The Arduino Installer should install the USB Driver automatically. But in case it doesn't
work, download from the link. Windows 10 users should use CP210x Universival Windows Driver, and
Windows 8.1,8 and 7 users can use CP210x Windows Driver.

- MacOS Users: Download the CP210x VCP Mac OSX Driver. After installing, accept Privacy changes

and prompts. If install fails, install legacy driver variant.

- Testing if the USB driver works (all OS): in the Arduino menu Tools>port *before* plugging in your ESP
with the USB cable. You should see either none or one entry listed. Now plug in your ESP
microcontroller and take another look at Tools>port. You should hopefully see one more entry. On

Windows this will often be something like COM3. On Mac it will be USB_to_UART or cu.usbserial
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TESTING AND GETTING INFO

- Open File=>Examples = Basics = BareMinimum and test that upload works to your ESP32.

- During upload the device MAC adress will be written (including other useful info)

Connecting

Chip is ESP32-DOWD-V3 (revision v3.1)

Features: WiFi, BT, Dual Core, 240MHz, VRef calibration in efuse, Coding Scheme None
Crystal is 40MHz

MAC: [Bc:8a:1f:0c:64:00

Uploading stub...

Running stub...

Stub running...

Changing baud rate to 921600

- Now it’s time to get on WiFi, by either using your phone hotspot as WiFi, or connect to AU-loT via Simon

(bring him your device MAC address)
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GETTING ON WIFI

const char

const char

void
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_ Or your phone hotspot SSID + pass

QE—

//Optional
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GETTING ON WIFI

Output  Serial Monitor X ==

- Result 1: M0 Enter o sena message to E5p2 Dev Moauls' on feevcuusosers-ooot) | Newkinel = ozicoobaue =

27027020 A 27 L2 2 2 2 22 2 2

Connecting

Connected to the WiFi network
Local ESP32 IP: 10.116.132.23

- Result 2: Endless connecting loop (retry SSID/pass or another WiFi)
- Result 3: Connection failed (retry)

- Result 4: Gibberish (check baud rate).
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REACTING TO ONLINE INPUT

- Open the .ino file from Brightspace called "ESP32_WifiWorkshopFinal” (unedited code can also be
found via link, remember to change SSID credentials and baud).

- Read through to understand what it does. It is a very basic HTTP-request "ESP32 as web server”’-setup,
and is great for future prototyping!

- Set up a breadboard with your ESP and two LEDs to pin 26 and 27 (remember a 220 ohm resistor to
each + GND pin)

- Use your computer/phone to control the pins (write the IP in the URL-field in a browser)

- Optional - loT Doorbell: Edit the code to work with a single buzzer instead of two LEDs - maybe even
make a little melody?

Idea and code from: https://randomnerdtutorials.com/esp32-web-server-arduino-ide/
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